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WHERE TO START WITH THE NI 435X

This document explains how to begin using the National Instruments 

4350/4351 (NI 435X) high-precision data acquisition (DAQ) temperature 

and voltage meters for PCMCIA, USB, PCI, and PXI/CompactPCI buses.

Conventions

The following conventions are used in this document:

» The » symbol leads you through nested menu items and dialog box options 

to a final action. The sequence File»Page Setup»Options directs you to 

pull down the File menu, select the Page Setup item, and select Options 

from the last dialog box.

♦ The ♦ symbol indicates that the following text applies only to a specific 

product, a specific operating system, or a specific software version.

This icon denotes a note, which alerts you to important information.

This icon denotes a caution, which advises you of precautions to take to 

avoid injury, data loss, or a system crash. When this symbol is marked on 

the product, refer to the Read Me First: Safety and Radio-Frequency 

Interference document, shipped with the product, for precautions to take.

bold Bold text denotes items that you must select or click in the software, such 

as menu items and dialog box options. Bold text also denotes parameter 

names.

italic Italic text denotes variables, emphasis, a cross reference, or an introduction 

to a key concept. This font also denotes text that is a placeholder for a word 

or value that you must supply.

monospace Text in this font denotes text or characters that you should enter from the 

keyboard, sections of code, programming examples, and syntax examples. 

This font is also used for the proper names of disk drives, paths, directories, 

ni.com
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programs, subprograms, subroutines, device names, functions, operations, 

variables, filenames and extensions, and code excerpts.

NI 435X Refers to all devices in the National Instruments 4350 and 4351 families.

Unpacking the Kit

Follow the unpacking instructions below that correspond to the 

NI 435X device.

♦ NI PCMCIA-4350

The NI PCMCIA-4350 is shipped in an antistatic vinyl package; when you 

are not using the NI PCMCIA-4350, store it in the antistatic vinyl package. 

Because the NI PCMCIA-4350 is enclosed in a fully shielded package, 

no additional electrostatic discharge (ESD) precautions are necessary. 

However, for your own safety and to protect the NI PCMCIA-4350, never 

touch the connector pins.

♦ NI PXI-4351 and NI PCI-4351

The NI PXI-4351 and NI PCI-4351 ship in antistatic vinyl packages that 

prevent electrostatic damage to the device. ESD can damage several 

components on the device. To avoid such damage when handling the 

device, take the following precautions:

• Ground yourself using a grounding strap or by holding a grounded 

object.

• Touch the antistatic package to a metal part on the computer chassis 

before removing the device from the package.

• Remove the device from the package and inspect the device for loose 

components or any other sign of damage. Notify NI if the device 

appears damaged in any way. Do not install a damaged device in the 

computer.

• Never touch the exposed connector pins.

• Do not touch the printed circuit board or any components on the board 

because this may affect performance of the device.

Caution The NI PXI-4351 and NI PCI-4351 are ESD/contamination sensitive. Handle the 

board using the edges or metal bracket.

♦ NI USB-4350

The NI USB-4350 is shipped in an antistatic vinyl package; when you are 

not using the NI USB-4350, store it in the antistatic vinyl package. Because 

the NI USB-4350 is enclosed in a fully shielded package, no additional 
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ESD precautions are necessary. However, for your own safety and to 

protect the NI USB-4350, never touch the connector pins.

What You Need to Get Started

To set up and use the NI 435X device, you need the following items:

❑ A computer

❑ One of the following NI 435X high-precision DAQ devices:

– NI PCMCIA-4350

– NI USB-4350

– NI PXI-4351

– NI PCI-4351

❑ NI-DAQ 6.9.3 or higher for PC compatibles

❑ Logger Soft Front Panel 1.0.1 or higher

❑ If you want to program with the device, use one of the following 

software packages and documentation:

– LabVIEW 6.1 or later

– Measurement Studio LabWindows™/CVI™ 4.0 or later

– Measurement Studio for Visual Basic

– Third-party compiler

❑ Optional cables and accessories

❑ Read Me First: Safety and Radio-Frequency Interference

❑ VI Logger Soft Front Panel Note to Users

❑ Getting Started with VI Logger

Installing the Software

Install NI-DAQ and the application software before you install the 

NI 435X device. If you are using LabVIEW, Measurement Studio 

LabWindows/CVI, or Measurement Studio for Visual Basic, refer to their 

software release notes for installation instructions. If you are using 

programming languages such as Visual Basic, C, or C++ with NI-DAQ, 

follow the NI-DAQ release note instructions for installing third-party 

compilers.
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Complete the following steps to install the NI 435X software, which 

includes NI-DAQ 6.9.3, Logger Soft Front Panel 1.0.1, and the NI 435X 

instrument driver:

1. Insert the NI-DAQ 6.9.3 installation CD. Follow the instructions that 

appear on the screen.

2. Insert the Logger Soft Front Panel 1.0.1 and NI 435X instrument driver 

CD. Follow the instructions that appear on the screen.

3. Click OK to restart the computer.

After you install the software, you are ready to install the NI 435X 

hardware. Refer to the Installing the NI 435X section for further 

instructions.

Installing the NI 435X

Caution Refer to the Read Me First: Safety and Radio-Frequency Interference document 

before removing equipment covers or connecting/disconnecting any signal wires.

Power off the computer and, depending upon the device type, install the 

NI 435X following the instructions in this section.

Note You can plug in the NI PCMCIA-4350 and NI USB-4350 at any time after the 

drivers are installed without powering off the computer.
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♦ NI PCMCIA-4350

Figure 1.  NI PCMCIA-4350 System

You can install the NI PCMCIA-4350 in any available Type II PCMCIA 

slot in the computer.

Windows 98 or later includes the Plug and Play services that the operating 

system uses. Windows NT 4.0 or higher includes the drivers needed to use 

PCMCIA cards. The operating system configures the NI PCMCIA-4350 

and automatically assigns the base address and the interrupt level. The 

following are general installation instructions, but consult the PC user 

manual or technical reference manual for specific instructions and 

warnings:

1. Write down the NI PCMCIA-4350 serial number for future reference.

2. Power off the computer.

Note If the computer and operating system support hot insertion, you can insert or remove 

the NI PCMCIA-4350 at any time, even if the computer is powered on.

3. Remove the PCMCIA slot cover on the computer.

1 Portable Computer
2 PCMCIA Socket

3 NI PCMCIA-4350

1

2

3
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4. Insert the 68-pin I/O connector of the NI PCMCIA-4350 into the 

PCMCIA slot until the connector is firmly seated. The 

NI PCMCIA-4350 connectors are keyed so the device can only be 

inserted in one way.

The NI PCMCIA-4350 is now installed. Refer to the Configuring and 

Testing the NI 435X section next.

♦ NI USB-4350

Figure 2.  NI USB-4350 with USB Cable

Note The NI USB-4350 is only supported in Windows 2000/XP/Me/98.

You can connect the NI USB-4350 to any available USB connector that 

supports high-power, bus-powered peripheral devices. The following are 

general installation instructions, but consult the PC user manual or 

technical reference manual for specific instructions and warnings.

1. Connect the USB cable from the computer port or from any other hub, 

to the port on the NI USB-4350.

2. The computer should immediately detect the NI USB-4350. When the 

computer recognizes the NI USB-4350, the LED on the front panel 

blinks or lights up, depending on the state of the device.

If the LED lights up after the NI USB-4350 is connected to the host, 

the NI USB-4350 is functioning properly. If the LED remains off or 

blinks, refer to Table 1.

1 NI USB-4350
2 Downstream USB Connector

3 Upstream USB Connector to PC

1

3

2
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The NI USB-4350 is now installed. Refer to the Configuring and Testing 

the NI 435X section next.

Table 1.  LED Patterns for the NI USB-4350 States

LED NI USB-4350 State Description

On Configured state The NI USB-4350 is 

configured.

Off Off or in the 

low-power, suspend 

mode

The NI USB-4350 is powered 

off or in the low-power, 

suspend mode.

1 blink Attached state The NI USB-4350 is 

recognized, but not 

configured.

2 blinks Addressed state The host computer detects the 

NI USB-4350, but cannot 

configure it because NI-DAQ 

is improperly installed or 

system resources are 

unavailable. Check the 

software installation.

3 blinks Power supply failure The internal power supply 

shut down. Refer to the Power 

Considerations for the 

NI USB-4350 section in the 

NI 435X User Manual for 

more information.

4 blinks General error state Contact NI. Refer to the 

Technical Support Resources 

section for contact 

information.

The LED blinks in one-second intervals during each cycle. The LED 

then waits three seconds before repeating the cycle.
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♦ NI PXI-4351

Figure 3.  NI PXI-4351 with PXI Chassis

You can install the NI PXI-4351 in any available 5 V peripheral slot in the 

PXI or CompactPCI chassis.

Note The NI PXI-4351 does not have connections to reserved lines on the CompactPCI 

J2 connector. Therefore, you can use the NI PXI-4351 in a CompactPCI system that uses 

J2 connector lines for purposes other than PXI.

1. Write down the NI PXI-4351 serial number for future reference.

2. Plug in, but do not power on, the PXI or CompactPCI chassis.

Caution To protect both yourself and the computer from electrical hazards, do not power 

on the computer until you finish installing the NI PXI-4351.

3. Choose an unused PXI or CompactPCI 5 V peripheral slot.

4. Remove the filler panel for the peripheral slot you selected.

5. Touch a metal part on the chassis to discharge any static electricity that 

might be on your clothes or body.

Caution The NI PXI-4351 is ESD/contamination sensitive. Handle the device using the 

metal bracket or edges.

1 PXI Chassis
2 NI PXI-4351

3 Ejector Handle in Down Position

8

7

6

5

4

3

2

1

ON

STANDBY

1

2

3
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6. Insert the NI PXI-4351 into the selected 5 V slot. Use the 

injector/ejector handle to fully insert the device.

7. Use the screw on the front panel of the NI PXI-4351 to fasten the 

device to the front panel mounting rails of the PXI or CompactPCI 

chassis.

8. Visually verify the installation.

9. Plug in and power on the PXI or CompactPCI chassis.

The NI PXI-4351 is now installed. Refer to the Configuring and Testing the 

NI 435X section next.

♦ NI PCI-4351

Figure 4.  NI PCI-4351 with PC

You can install the NI PCI-4351 in any available PCI expansion slot in the 

computer. However, to achieve the best noise performance, leave as much 

room as possible between the NI PCI-4351 and other boards and hardware. 

The following are general instructions, so consult the computer user 

manual or technical reference manual for specific instructions and 

warnings.

1. Write down the NI PCI-4351 serial number for future reference.

2. Plug in, but do not power on, the computer before installing the 

NI PCI-4351 device. The power cord grounds the computer and 

protects it from electrical damage while you are installing the module.

1 PC
2 NI PCI-4351

3 PCI Expansion Slot

1

2

3
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Caution To protect both yourself and the computer from electrical hazards, do not power 

on the computer until you finish installing the NI PCI-4351.

3. Remove the top cover or access port to the PCI bus.

4. Select any available PCI expansion slot.

5. Locate the metal bracket that covers the cut-out in the back panel of the 

chassis for the slot you selected. Remove and save the 

bracket-retaining screw and the bracket cover.

6. Touch the metal part of the power supply case inside the computer to 

discharge any static electricity that might be on your clothes or body.

Caution The NI PCI-4351 is ESD/contamination sensitive. Handle the device using the 

metal bracket or edges.

7. Line up the NI PCI-4351 with the 68-pin connector near the cut-out on 

the back panel. Using slow, evenly distributed pressure, press the 

NI PCI-4351 straight down until it seats in the expansion slot.

8. Reinstall the bracket-retaining screw to secure the NI PCI-4351 to the 

back panel rail.

9. Visually verify the installation.

10. Replace the computer cover and power on the computer.

The NI PCI-4351 is now installed. Refer to the Configuring and Testing the 

NI 435X section next.

Configuring and Testing the NI 435X

The NI 435X is a completely software-configurable, Plug and Play device. 

The Plug and Play services query the device and allocate the required 

resources; then, the operating system enables the device for operation.

Complete the following steps to configure and test the NI 435X:

1. Launch Measurement & Automation Explorer (MAX) from the 

computer.

Note You may want to first refresh <F5> in MAX.

2. Expand Devices and Interfaces.

3. Right-click the NI 435X device and select Properties. In the System 

window, note the Device Number that was assigned. Use this device 

number when you program the device.
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4. From the System window, click Test Resources to test the NI 435X 

resources. A dialog box appears and indicates whether the resource test 

was passed.

5. In the Accessory window, select the accessory, if any, attached to the 

NI 435X device.

Note Selecting the accessory allows NI-DAQ to make use of accessory features, such as 

a cold-junction compensation channel.

6. From the System window, click Run Test Panels to run functional test 

panels.

7. Connect a signal to an input channel on the attached accessory.

8. Select the Channel, Input Limits, and Sensor Type settings. If the 

sensor type is a thermocouple, select the correct option in CJC Info. 

The NI 435X device immediately starts acquiring data.

9. When you finish testing, click Close and then OK in the Configuring 

Devices window.

When you finish configuring and testing the NI 435X, you can use Logger 

Soft Front Panel from within MAX. Use the Logger Soft Front Panel to 

control the NI 435X without doing any programming. Refer to the Logger 

Soft Front Panel Note to Users for a list of the available features. Refer to 

the Getting Started with VI Logger to learn how to use the available features 

of the Logger Soft Front Panel.

If you want to program in LabVIEW, refer to the NI-DAQ VI reference 

within LabVIEW Help and the NI 435X NI-DAQ examples for programs 

and examples for the NI 435X product. To access LabVIEW Help from 

within LabVIEW select Help»VI, Function, and How-To Help. To 

program with Measurement Studio LabWindows/CVI, Visual Basic, Visual 

C/C++, or a third-party software, install the NI 435X instrument driver 

available on the CD.

Technical Support Resources

NI Web Support
NI Web support is your first stop for help in solving installation, 

configuration, and application problems and questions. Online 

problem-solving and diagnostic resources include frequently asked 

questions, knowledge bases, product-specific troubleshooting wizards, 

manuals, drivers, software updates, and more. Web support is available 

through the Technical Support section of ni.com.
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Worldwide Support
NI has offices located around the world to help address your support needs. 

You can access our branch office Web sites from the Worldwide Offices 

section of ni.com. Branch office Web sites provide up-to-date contact 

information, support phone numbers, email addresses, and current events. 

If you have searched the technical support resources on our Web site 

and still cannot find the answers you need, contact your local office or NI 

corporate. For telephone support in the United States, dial 512 795 8248. 

For telephone support outside the United States, contact your local branch 

office: 

Australia 03 9879 5166, Austria 0662 45 79 90 0, Belgium 02 757 00 20, 

Brazil 55 11 3262 3599, Canada (Calgary) 403 274 9391, 

Canada (Montreal) 514 288 5722, Canada (Ottawa) 613 233 5949, 

Canada (Québec) 514 694 8521, Canada (Toronto) 905 785 0085, 

China 86 21 6555 7838, Czech Republic 02 2423 5774, 

Denmark 45 76 26 00, Finland 09 725 725 11, France 01 48 14 24 24, 

Germany 089 741 31 30, Greece 01 42 96 427, Hong Kong 2645 3186, 

India 91 80 4190000, Israel 03 6393737, Italy 02 413091, 

Japan 03 5472 2970, Korea 02 3451 3400, Malaysia 603 9596711, 

Mexico 001 800 010 0793, Netherlands 0348 433466, 

New Zealand 09 914 0488, Norway 32 27 73 00, Poland 22 3390 150, 

Portugal 210 311 210, Russia 095 238 7139, Singapore 65 6 226 5886, 

Slovenia 3 425 4200, South Africa 11 805 8197, Spain 91 640 0085, 

Sweden 08 587 895 00, Switzerland 056 200 51 51, 

Taiwan 02 2528 7227, United Kingdom 01635 523545
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